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1 Introduction

Our products are constantly being improved and updated. To keep as good as possible informed, we introduce a
complete new setup for our product Release Notes.

The Release notes are divided in the group, for example CardExchange® Release 7.1, and every group can
contain the following categories:

1. Designer
2. Four Clicks Interface
3. PhotoExchange
4. DataExchange
5. MifareExchange
6. DESFireExchange
7. DefinitionExchange
8. PrinterExchange
9. Small Business Server
10. Network Printing
11. Service Center

Every category will contain mostly 3 different sections:

1. New functionality
2. Improvements
3. Bug fixes

Our software solutions can only exist by means of our Partners and you, our Partner, is leading in providing
information regarding new functionality, preferred improvements, and discovered bugs. We encourage
you, to keep informing us about your wishes, thoughts, and issues that you discover during the use of our
software products.

ExchangeIt today offers almost 16 hour support coverage via our developers around the world. As a
ExchangeIt partner, please submit all your support request via our online ticket system or post them on the
CardExchange® forum. Motivate your customers as much as possible to use our forum. Adding your
thoughts, solutions, and questions, helps to grow the CardExchange® knowledge base and that will help our
end users around the world to create unlimited solutions.
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2 CardExchange® Release 7

Release date: November 20, 2012

With the release of CardExchange® 7.1 we are definitely have chosen a different way for the configuration of
CardExchange®. In this release of CardExchange® we are introducing full drag and drop functionality for database
data, but also manual entries.

The CardExchange®  Designer is becoming the configuration tool for CardExchange®. That means that we have
taken the first step and embedded the database configuration functionality into the Designer. When calling the
Designer, from the Configuration menu and choose 'Card Setup

We also took special care about the naming. Where we had to deal with naming like Edit Definitions, we now
have chosen for using names like Card Setup, Database Setup, etc.

Like stated, also the Designer is now named differently when you start the Card Setup mode

Depending of the edition running, CardExchange® will have the edition mentioned in the header followed by
(Configuration Mode). That makes more sense for the end-user to make him aware that he has a, in this
example, a Ultimate edition and is working in configuration mode.

In the configuration mode you see that there is a new tab available called Data

In this Data tab you can now define your database connections by selecting from the Connection section:
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Edit
New
Select
Remove

When you click on Edit or New, the Database connection wizard will start and you can follow the process as has
always been. After creating a new database connection, you will be asked to store this connection on a location
on your computer. So you do not define the name anymore before you start, but just like in all Windows
application, at the end. When you choose Select, an existing database connection can be selected.

The Data tab also contains an Record navigation section. This gives you the opportunity to browse through the
data of the connected database to see if all fits into the objects you have on the layout.

After you have created a new database connection, you will see that a new tab in the explorer window at the
right side:

The data tab contains all the available database columns from the
database or connected Excel file.

It is now just a matter of selecting one of the columns and drag it to the
layout of the card.

When you have the Properties window opened, you can also find a new tab called Database columns:
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Also here you can select the available database columns and drag them to the layout of the card. Overall it does
not matter how you want to get the data on the layout anymore. You can select and drag it to the card, you can
directly select the database or object when adding a new object to the layout, and if you need to change
something, just select the database column and throw it into the content text box... It is that easy!

IMAGE OBJECTS LIKE PHOTO'S AND SIGNATURES

Also the image objects are changed. To make sure there is no confusion with the end-user, the moment a
image object is selected, you will be offered 4 choices:

Fixed image
Photo
Signature (Starting Premium Edition)
Variable Image (Starting Premium Edition)

When the database column contains the image data, the object will now directly know what to do. No selection
is needed for the user. It will also generate the point to image file for connections to images via Excel.

DEFINING MANUAL ENTRIES

Also new is the creation of Manual Entries. In the Properties window you can find a new tab called Manual
Entries.
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Just click on Add manual entry and enter a label, indicated as 'Label1', and enter a standard value, indicated as
'Value1'. After you have created the manual entry, just select it with the mouse and drag it onto the card layout.
In the content tab of the Properties, you can set all the needed options.

2.1 Installer

In this section of the release notes you can find all the fixes and improvements made for our installer.
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2.1.1 Improvement

Release 7.2.2.0 (July 25, 2013)

Changed the default data folder to the public-documents folder if the installation is done for all users

(default).

2.2 Activation Wizard

With the release of CardExchange® version 8, we introduced registration of the software via the activation
wizard in stead of via our website also in version 6 and version 7. This brings two different database systems
together and makes it more convenient  to present the registration data via the license system. This information
will become available in the eMarketing CMS system.

2.2.1 Improvement

Release 7.2.0.3 (May 1, 2013)

When an error occurs when starting up the registration wizard, the error is not shown any more for timeout

and end-point-not-found exceptions. Instead, the generic message “Registering the license or modifying the

registration data is currently not possible, since there is no connection to the registration server. Please, make

sure that your computer is connected to the Internet.” is displayed.



CardExchange® Release Notes10

© 2013 ExchangeIt B.V.

2.2.2 Bug Fixes

Release 7.2.0.3 (May 1, 2013)

When the registration was updated during the validity of the 30-days Ultimate trial period and the use-trial-

period option was disabled in the registration wizard, the trial period was not disabled.

When an error occurred after clicking Finish in the activation wizard, it was not possible to close the wizard

and the application has to be killed in the Windows task manager.

Release 7.1.3.1 (February 18, 2013)

In some occasions, the Next button in the evaluation page was disabled when starting up CardExchange

without a valid license.

It was not possible to activate a license with a *.LIC file. The fatal error “Conversion from string “” to type

‘Integer’ is not valid. Input string was not in a correct format.” occurred when trying to do so.

2.3 Designer

The Designer comes as a stand alone edition but is also the tool to design cards, database connections, etc. In
this way it will appear as the edition running with mentioned (Configuration Mode) mentioned in the header.

2.3.1 New Functionality

Release 7.2.2.0 (July 25, 2013)

Made it possible to drag and drop database and other fields from the data tab to the concatenation button in

the content tab for a faster configuration of concatenation mappings.
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Added a check box to the Content tab of the properties window that determines whether concatenation

fields should be separated by spaces.

Release 7.2.0.3 (May 1, 2013)

Made it possible to map storage items, storage-item keys and script variables in the Data tab of the main

window.

Made it possible to drag-and drop manual entries and database columns from multiple databases from the

Data tab in the main window.

Added basic background-removal functionality to the Visibility tab of the Properties window.

Release 7.1.0.0 (November 20, 2012)

Added Database connection functionality to the Designer

Added Record Navigation functionality to the Designer

Added Drag and Drop functionality for database columns

Added Drag and Drop functionality for manual entries

Made it possible to define your Entry-level objects in the designer, instead of using the mapping window

Show the designer's properties window automatically to first-time users.

Added the options: “Prompt for a value before printing”, “Value cannot be empty” and “Show previous value”

for manual-entry mappings.

Added the options “Next value to be printed” and “Increment value” to the content tab, in case the selected

object has been mapped as global counter.

Updated the Dutch, German, Portuguese and Spanish translations.

Release 7.1.2.0 (February 5, 2013)

Added support for Signotec signature pads

The registration process has been integrated in the activation wizard.

In some languages, the formatted names were shown with parenthesis around each name (Danish,

Norwegian, Greek and Indonesian).

2.3.2 Improvements

Release 7.2.4.0 (October 1, 2013)

Added the option to print via the GDI+.

Added the option to pre-render objects into the background image of the layout page. With this property,

graphics that is not supported by GDI+ can be sent to the printer as bitmap, while objects that need to be

printed in resin black can still be sent separately.
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Release 7.2.2.0 (July 25, 2013)

When a binary database field is dropped on the design area, it is mapped as photo, rather than variable image.

When double clicking on a content data item in the data tab of the main window, the Content tab of the

Properties window is shown automatically.

Added a help icon to the Concatenation button to provide more explanation.

When creating a new concatenation, separate it with spaces by default.

Release 7.2.0.3 (May 1, 2013)

Made it possible to set the desired crop ratio for photo and signature mappings

Card designs are first saved to a temporary file to avoid that errors that occur during saving leave a corrupted

template file.

When an object type has been selected for insertion and the mouse is moved over the work area, the cursor

changes in a cross.

Show the wait cursor for every command that is executed.

Also enable the DPI setting in the page-setup window when the option “send to printer as bitmap” has not

been checked. The DPI setting is used when determining the resolution of bar-code images.

Allow for escaping Unicode characters in the prefix and suffix fields for mappings using hexadecimal codes,

by typing for example “#&H409;” (equivalent to “#1033;”).

Release 7.1.1.0 (January 2, 2013)

With the new Zenius & Primacy Driver (v. 5.0.4.181 - released on November 22 2012) there is no need to use

the SDK for magnetic encoding anymore. By default the SDK will not be used anymore. It is possible to force

the use of the SDK by adding Mag to the end of the printer name.

Updated the French translation.

When the front size of a two sided card is deleted, the former back side is made the front side and its

printable property is copied from the former front side.

2.3.3 Bug Fixes

Release 7.2.4.0 (October 1, 2013)

When selecting the mapping type Script for a variable in the content tab, the following error occurred: ‘…’ is

not a valid value or property ‘Text’.

Avoid that the designer window opens outside the desktop area.

Release 7.2.2.0 (July 25, 2013)

Restored the lost translations from the previous version for the following languages: German, Spanish, French,

Dutch, Portuguese and Romanian.
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When making changes to the database setup from the main window, like adding a storage item, these

changes were not applied to the card template when opening it in the designer.

The name-case formatting option did not change uppercase to lowercase when necessary.

When opening a design that is connected to an empty database table or view, the database columns were

not shown in the Data tab and in the drop-down menus on the Context menu, and any mappings were

shown as {Missing column}.

When specifying to print multiple copies in the print dialog, only a single copy is actually being printed.

Release 7.2.0.3 (May 1, 2013)

When a shape was added, an empty insert-window was shown.

When clicking on the Select-connection button in the Data menu and canceling the selection, the Edit and

Remove-connection buttons became enabled, even though there was no connection.

When there were non-existing database columns, selecting multiple objects could lead to a null-reference

exception.

If the My Pictures folder was not properly defined on a system, starting CardExchange® resulted in a fatal

error: “The type initializer for ‘CardExchangeDesignerX.cedImages’ threw an exception. Invalid URI: The

format of the URI could not be determined.”

When connecting to SQL Server and using a unique identifier as primary key, the following error could occur

when opening or viewing the version 7 designer: “Conversion from type ‘Guid’ to type ‘String’ is not valid.”

When navigating to a record for which no photo is available, with the background-removal option enabled for

that photo, a null-reference exception occurred.

Using fixed values for concatenation fields caused CardExchange® to crash.

It was not possible to do contactless and magnetic encoding in the same print process using a Magicard Prima

4 or a DNP CX-D80.

In the properties window, the data for magnetic tracks was shown with escaped spaces (#32) and other

special characters.

Text data in magnetic tracks are now always converted to uppercase.

Made sure that a template can be opened in the designer if there is no connection to the database.

Adding a variable directly after starting up the designer caused a null-reference exception.

Special characters in the start and stop commands of magnetic tracks were shown escaped instead of

normally.

When exporting an image from the application menu, the saved image format was not in accordance with

the saved file extension.

Release 7.1.1.0 (January 2, 2013)

Correctly included support for the OmniKey 5x27 reader.

Trying to stack ellipses, rectangles or lines led to the error “Layout measurement override of element



CardExchange® Release Notes14

© 2013 ExchangeIt B.V.

‘CardExchangeDesignerX.cedRectangle’ should not return PositiveInfinity as its DesiredSize, even in Infinity is

passed in as available size.”

Make sure that any special characters in the string-type properties are handled correctly, including trailing

carriage return characters.

Trying to drag and drop a manual entry while that was being renamed led to the error “Dispatcher processing

has been suspended, but messages are still being processed.”

When a member function was called on a variable in an expression, the designer did not prompt for adding

that variable.

When editing the data definition in the designer, the changes were not processed by the four-clicks and were

effectively undone when closing CardExchange.

When starting the designer for a template with a MySQL connection, errors showed up and the records could

not be read properly. The error message was similar to “You have an error in your SQL syntax; check the

manual that corresponds to you MySQL server version for the right syntax to use near ’20 * FROM

`table_name`’ at line 1”.

Switching between records was very slow due to an inefficient rendering of the database tab in the

properties window.

When enabling a track of the magnetic stripe in the content tab of the properties window, the error "'~1%' is

not a valid value for property 'Prefix'." was shown.

When creating a new template in the card definition wizard, the data definition was not correctly associated

with the new template.

Templates with a database connection that contained a date/time field could cause errors when being loaded

in a different culture than the one they were created in.

When the mapping of a text or bar-code object yielded a numeric or date/time value, no data was shown in

the object.

When navigating in the designer, photos and signatures on the design were not updated, while variable

images worked fine.

When having an ODBC connection to a non-Microsoft type database, starting the design caused a SQL syntax

error due to the fact that the “TOP 20” was not recognized. Since there is no generic ODBC syntax, the

designer now loads the entire table in case of ODBC connections.

When typing a script with new variables in the content tab of the properties window, the insert-variables

dialog did not show when committing the change and the script was deleted.

When changing the file extension of a photo to “Extension included in source value”, saving or printing the

card resulted in the error “Value cannot be null. Parameter name: input”.

When a rotated group was ungrouped, the grouped objects did not maintain their rotation settings. The same

problem occurred with stacks.

Release 7.1.0.0 (November 20, 2012)
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After changing the language via the View menu, the sort order in the drop-down menus was not restored.

Images with the extension *.tiff were not shown in the file dialog for selecting images.

It was not possible to delete the expression for a layout condition.

When closing CardExchange immediately after removing a photo using the Remove button in the Photo tab

the fatal error message “A fatal error occurred in CardExchange. Object reference not set to an instance of an

object.” was shown.

When inserting new records into SQL Server from various work stations, CardExchange often selected the

wrong record when insertion was completed. When trying to select already deleted records, this could even

lead to error messages.

Now, when a null field is send to a magnetic object it is just not handled instead of showing an error dialog,

like previously.

Editing, removing, copying and pasting photos and signatures did not always work correctly.

Avoid saving properties with default values to the .cedx file.

Corrected the image background of the button “Previous record”.

When changing an image mapping from Photo to Script and then back to Photo, the database-column drop-

down menu was not shown anymore.

Positioned the magnetic stripe on the top of the card instead of the bottom.

Scripts that were defined on attached properties (Left, Top, Printability) were not executed during printing.

2.4 Four Click Interface

In this section you can find all the fixes, improvements, etc., for the Four Click Interface of CardExchange®.
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2.4.1 New Functionality

Release 7.2.4.0 (October 1, 2013)

Made it possible to run CardExchange in support mode, offering the possibility to choose the desired edition

prior to launching the main window. If the chosen edition is higher than the license one, the licensed edition

will launch.

Made it possible to run CardExchange with a networked demo license.

Release 7.2.0.3 (May 1, 2013)

Added support to magnetic encoding via SDK for VDS CX-80D and Magicard Prima 4 printers.

Release 7.1.2.0 (February 5, 2013)

The registration process has been integrated in the activation wizard.

Added support for Signotec signature pads.

2.4.2 Improvements

Release 7.2.2.0 (July 25, 2013)

The storage-item type (supply value, photo or signature) is now determined in the database setup and does

not need to be set anymore in the card setup. WARNING: If an existing template has a storage item that is

used for signatures or button-triggered plug-in output. It is necessary to select the correct storage item type
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in the database setup, as by default they will be set to Photo.

When running in demo mode, the number of days left in the window header counts down from 42 to zero

and then stays on zero forever (the demo mode never really expires).

Automatically open the user-authorizations wizard when logins are enabled and force the user to walk

through the wizard.

Changed the default time delay after printing to 0.1 second, to avoid slow printing in demo situations.

Do not show binary database fields in the new-card wizard when electing a binary database field makes no

sense (text columns, bar-code column).

Changed the page order for adding objects to the layout in the new-card wizard to background - logo - photo

and signature - text columns -bar code.

Changed logins feature to fit the new edition features list (Premium edition is limited to 5 groups and 7 users

and Professional edition doesn't allow password expire feature and specific user permissions definitions).

Release 7.2.0.3 (May 1, 2013)

Added the Romanian language support.

Release 7.1.3.1 (February 18, 2013)

Changed the text of the migration button into “Migrate version 6 layout”.

Release 7.1.1.0 (January 2, 2013)

Included Video-for-Windows support in the Entry edition.

Release 7.1.0.0 (November 20, 2012)

Show the advanced mappings by default to Premium and higher users.

Do not show the card category in the footer of the current-card group of the configuration tab.

Adapted the header of the four-clicks interface to Office standard.

Textual improvements.

All PhotoExchange sources (From file; Twain/WIA; DirectShow; Canon) are now available in Entry edition and

higher. Face recognition is available in Professional and Ultimate.

2.4.3 Bug Fixes

Release 7.2.4.0 (October 1, 2013)

Avoid that CardExchange, when starting, tries to open a card for which the current user is not authorized.

Avoid that the configuration buttons for the current card are not available after starting CardExchange with a

failing database connection.

The trial markers for PhotoExchange and PhotoExchange Pro were not shown when running in 30-days
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Ultimate trial mode.

When an unsupported Signotec pad is used CardExchange freezes after the signature acquisition

Release 7.2.2.0 (July 25, 2013)

Removed options that do not apply to the current edition from the advanced-options form.

When taking a photo and capturing immediately after that a signature, the photo on the preview was

reverted to the previous one.

Sometimes, the company logo in the service-center ribbon did not show correctly.

Removed the empty navigator tab in the last page of the user-authorizations wizard.

Corrected the configurable of some help-menu options in the user-authorizations wizard.

When adding a new card without a database connection but with a photo or a signature, clicking Finish in the

new-card wizard caused a null-reference exception.

Release 7.2.0.3 (May 1, 2013)

When the Guest user was deleted in the user-authorizations wizard, clicking Next resulted in the following

error: “Deleted row information cannot be accessed through the row.”

Included the correct version the SigPlusNET.dll for signature-pad support.

When the connection to a database was not successful, it was not possible to start up the Database

Connection Wizard to correct the settings.

Release 7.1.3.0 (February 13, 2013)

When no valid demo license was found or the demo license was expired, it was still possible to select

evaluate in the activation wizard, which would result various error messages.

When clicking Next in the activation page of the activation wizard, no wait cursor was shown, despite the fact

that it could take about second before the next page was shown.

In the activation wizard, the registration input fields were initially enabled despite the fact that the

registration option was initially unchecked.

The use trial period option is now disabled when no trial period is available.

When the registration form was called without internet connection, an activation error was shown, instead of

a normal pop-up error.

The registration reminder shown when closing CardExchange was still referring to the old registration

website.

When upgrading CardExchange from an older version, the demo license code was not installed and

CardExchange could not be run in demo mode unless the lservrc file was deleted first.

When enabling the Migrate button in the Entry edition, the Authorization became visible.
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Release 7.1.2.0 (February 5, 2013)

In some languages, the formatted names were shown with parenthesis around each name (Danish,

Norwegian, Greek and Indonesian).

Release 7.1.0.0 (November 20, 2012)

If a card definition was defined to just do contactless encoding and both print front and print back were

disabled, the card was not ejected and the same card was used for the entire batch.

If not all button group fitted on the available space of Configuration tab, the migration button was not hidden

appropriately.

The data-text objects created by the step-by-step wizard were not distributed evenly on the created

template.

When canceling the user-authorizations wizard, the changes made in the wizard were not undone.

When trying to print a card without database connection but with photo, for which the photo did not exist,

the message “No cards printed” was not shown.

When opening the edit-card wizard for one of the standard layout, changing the layout extension to “.ced”,

editing the layout and then changing the extension back to “.cedx”, the following error occurred: “A fatal

error occurred in CardExchange. ‘Cannot create unknown type ‘TfrxReport’.’ Line number ‘2’ and line position

‘2’.”

Solved a number of bugs related to the correct and efficient handling of photos and signatures.

Fixed the “Could not add a new card definition. Object reference not set to an instance of an object” error

when starting with an empty data folder.

When running in  demo mode the photos were not marked with the demo watermark string.

2.5 DataExchange

In this section you can find all the updates with regards to the available database connectivity functionality.

2.5.1 Bug Fixes

Release 7.2.4.0 (October 1, 2013)

Remove any non-printable characters from the values of string-type database columns, to avoid illegal-

character errors in the designer.
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2.6 PhotoExchange

In CardExchange® we offer a lot of photo capture functionality. In this section of the release notes you will find
all the new functionality, improvements, and bug fixes for this functionality. 

2.6.1 Bug Fixes

Release 7.2.2.0 (July 25, 2013)

The live image was distorted if another crop ratio tan 3:4 was selected for the photo.

2.7 MifareExchange

This section contains all updates with regards to Improvements, Bug Fixes, Improvements, etc. for the MIFARE®
Classic encoding functionality. This functionality is available in our Ultimate Edition.

2.7.1 New Functionality

Release 7.2.0.3 (May 1, 2013)

Added Mifare Classic support for OmniKey 5x27 CK readers

Release 7.1.0.0 (November 20, 2012)

OmniKey 5x27CK support for H10301 and H10302 Prox cards.

2.8 DESFireExchange

This section contains all updates with regards to Improvements, Bug Fixes, Improvements, etc. for the MIFARE®
DESFire encoding functionality. This functionality is available in our Ultimate Edition.
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2.8.1 New Functionality

Release 7.2.0.3 (May 1, 2013)

The DESFire definition wizard now supports the MIFARE® Secure Application Module SAM AV2 on OmniKey

5x21 dual card readers.

Support the creation of value files.

2.8.2 Bug Fixes

Release 7.2.4.0 (October 1, 2013)

Since the introduction of support for value files, it was not possible anymore to read data from backup data

files, even though the command interface is the same as for standard data files.

Release 7.2.0.3 (May 1, 2013)

Corrected the text of the master-key setting that allows for creating (and not for deleting) applications

without authentication.

It was not possible to specify diversification input that contained the card´s UID when using the OmniKey

reader with SAM AV2.

2.9 PrinterExchange

In this section you can find all the updates with regards to the available printer functionality.

2.9.1 New Functionality

Release 7.1.2.0 (February 5, 2013)

Added support for Zebra ZXP7 inline contactless encoding

Release 7.1.0.0 (November 20, 2012)

Added support for DIGID XID9300 and PPC RTP9300 printers.

Release 7.1.2.0 (February 5, 2013)

Included Video-for-Windows support in the Entry edition

2.9.2 Improvement

Release 7.2.0.3 (May 1, 2013)

Updated Pointman SDK to version 2.1.5.3 to support firmware V142.

2.9.3 Bug Fixes

Release 7.2.4.0 (October 1, 2013)

When error 0x01062800 (Medium Changed) occurs with a JVC CX-D80 or Magicard Prima 4, the software will
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wait until the printer finishes to load the card into the encoder position instead of throwing an exception. This

is not a fault condition but rather a status message.

Release 7.1.0.0 (November 20, 2012)

Changed the Evolis sdk error handling to not stop the batch print process when an error like empty tray

happens.

Implemented a switch to revert back to escape commands for Evolis and Magicard printers, to use escape

commands the SDK string needs to be removed from the class name in the PrintersList.xml file.

2.10 Small Business Server

In this section you can find all the fixes, improvements, etc., for the Client, Printer Server, and Dispatcher of
CardExchange® Small Business Server.

2.10.1 Client

In this section you can find all the fixes, improvements, etc., for the Client of CardExchange® Small Business
Server.
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2.10.1.1 New Functionality

Release 7.2.3.2 (August 17, 2013)

Added the option Halt-client-on-error to the initialization file of the print server. If this option is set to False,

any print error that occurs in the print server will halt the print server, but the error will not be communicated

back to the client.

2.10.1.2 Improvement

Release 7.2.3.2 (August 17, 2013)

Added the port number to the computer name used by the print server for the purpose of data-folder locking.

This makes it possible to use data-folder locking with a client and multiple print servers on a single PC without

using user authorizations.

2.10.1.3 Bug Fixes

Release 7.2.3.2 (August 17, 2013)

Made it possible to do inline encoding with multiple Zebra ZXP 7 or 8 printers on a single computer.

2.10.2 Print Server

In this section you can find all the fixes, improvements, etc., for the Print Server of CardExchange® Small
Business Server.
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ic text
here.

2.10.2.1 Bug Fixes

Release 7.2.3.2 (August 17, 2013)

When selecting the Printer properties in the context menu, a null-reference exception occurred.
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3 CardExchange® Release 8

Release date: February 5, 2013

With the release of CardExchange® 8 we are definitely have chosen a different way for the communicating with
the customer. In this release of CardExchange® we are introducing CardExchange® eMarketing which allows you
to publish news items for your CardExchange® users..

In both the four click interface and designer we introduce the new Service center tab. In this Service
center the user can, besides the news items published, find direct links to Help, Forum, Video tutorials,
they can activate licenses like upgrades to higher editions, they can register the license, compare the
available editions, but most important, it shows two buttons. One button represent your company logo
and a direct link to your website. The second button is optional and only shown if you have a direct link
to your web shop. When the user click on this button, it will enter your web shop directly.

In the news item section, on the left side it shows all the available news items and by simply clicking on
it, the content of the item will be shown. For more information, please contact our Sales Department at
Sales@ExchangeIt24.com
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3.1 Installer

In this section of the release notes you can find all the fixes and improvements made for our installer.

3.1.1 Improvement

Release 8.1.2.0 (July 25, 2013)

Changed the default data folder to the public-documents folder if the installation is done for all users

(default).
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3.2 Activation Wizard

With the release of CardExchange® version 8, we introduced registration of the software via the activation
wizard in stead of via our website. This brings two different database systems together and makes it more
convenient  to present the registration data via the license system. This information will become available in the
eMarketing CMS system.

3.2.1 Improvement

Release 8.1.0.3 (May 1, 2013)

When an error occurs when starting up the registration wizard, the error is not shown any more for timeout

and end-point-not-found exceptions. Instead, the generic message “Registering the license or modifying the

registration data is currently not possible, since there is no connection to the registration server. Please, make

sure that your computer is connected to the Internet.” is displayed.

3.2.2 Bug Fixes

Release 8.1.0.3 (May 1, 2013)

When the registration was updated during the validity of the 30-days Ultimate trial period and the use-trial-

period option was disabled in the registration wizard, the trial period was not disabled.

When an error occurred after clicking Finish in the activation wizard, it was not possible to close the wizard

and the application has to be killed in the Windows task manager.
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Release 8.0.3.1 (February 18, 2013)

In some occasions, the Next button in the evaluation page was disabled when starting up CardExchange

without a valid license.

It was not possible to activate a license with a *.LIC file. The fatal error “Conversion from string “” to type

‘Integer’ is not valid. Input string was not in a correct format.” occurred when trying to do so.

3.3 Service Center

The Service Center is introduced in version 8 of CardExchange® and offers the user access to news items
published by it's reseller buy also allows access directly to the resellers website, web shop, etc. Together with all
other tools like Help, access to our Forum, Video Tutorials, etc., it is a TRUE Service Center.

3.3.1 Improvements

Release 8.1.3.0 (August 17, 2013)

Added an advanced option that makes it possible to show the service-center errors in case the posts do not

load correctly. For support purposes only.

Release 8.1.0.3 (May 1, 2013)

When an error occurs while CardExchange® is retrieving the news items, the error is not shown as anymore.

Instead, the generic message “Content cannot be loaded without internet connection” is displayed, no

matter what the actual cause of the error is.
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Release 8.0.2.0 (February 13, 2013)

When the Service Center tab is selected, pressing F5 results in the news items being refreshed.

3.3.2 Bug Fixes

Release 8.0.2.0 (February 13, 2013)

When there were no posts available or when there was no internet connection, the error “Object reference

not set to an instance of an object” showed up.

The Activate and Register buttons in the Service Center tab of the Designer did not show the renewed

wizard, but still referred to the old activation window and the registration website respectively.

3.4 Designer

The Designer comes as a stand alone edition but is also the tool to design cards, database connections, etc. In
this way it will appear as the edition running with mentioned (Configuration Mode) mentioned in the header.

3.4.1 New Functionality

Release 8.1.2.0 (July 25, 2013)

Made it possible to drag and drop database and other fields from the data tab to the concatenation button in

the content tab for a faster configuration of concatenation mappings.

Added a check box to the Content tab of the properties window that determines whether concatenation

fields should be separated by spaces.
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Release 8.1.0.3 (May 1, 2013)

Made it possible to map storage items, storage-item keys and script variables in the Data tab of the main

window.

Made it possible to drag-and drop manual entries and database columns from multiple databases from the

Data tab in the main window.

Added basic background-removal functionality to the Visibility tab of the Properties window.

Added support to magnetic encoding via SDK for VDS CX-80D and Magicard Prima 4 printers

Release 8.0.0.0 (February 5, 2013)

Show news items from the emarketing.cardexchangesolution.com in the Info tab

3.4.2 Improvement

Release 8.1.4.0 (October 1, 2013)

Added the option to print via the GDI+.

Added the option to pre-render objects into the background image of the layout page. With this property,

graphics that is not supported by GDI+ can be sent to the printer as bitmap, while objects that need to be

printed in resin black can still be sent separately.

Release 8.1.2.0 (July 25, 2013)

When a binary database field is dropped on the design area, it is mapped as photo, rather than variable image.

When double clicking on a content data item in the data tab of the main window, the Content tab of the

Properties window is shown automatically.

Added a help icon to the Concatenation button to provide more explanation.

When creating a new concatenation, separate it with spaces by default.

Release 8.1.0.3 (May 1, 2013)

Made it possible to set the desired crop ratio for photo and signature mappings

Card designs are first saved to a temporary file to avoid that errors that occur during saving leave a corrupted

template file.

When a connection error occurs in the service center, CardExchange® does not show the exception details

anymore.

When a card design is saved it’s generated a temporary file to avoid corrupted files when the save process

doesn’t executes correctly.

When an object type has been selected for insertion and the mouse is moved over the work area, the cursor

changes in a cross.

Also enable the DPI setting in the page-setup window when the option “send to printer as bitmap” has not
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been checked. The DPI setting is used when determining the resolution of bar-code images.

Allow for escaping Unicode characters in the prefix and suffix fields for mappings using hexadecimal codes,

by typing for example “#&H409;” (equivalent to “#1033;”).

3.4.3 Bug Fixes

Release 8.1.4.0 (October 1, 2013)

When the photo crop ratio is disabled in the designer, the face recognition returns an "Attempted to divide by

zero" exception.

When selecting the mapping type Script for a variable in the content tab, the following error occurred: ‘…’ is

not a valid value or property ‘Text’.

Avoid that the designer window opens outside the desktop area.

Release 8.1.2.0 (July 25, 2013)

Restored the lost translations from the previous version for the following languages: German, Spanish, French,

Dutch, Portuguese and Romanian.

When making changes to the database setup from the main window, like adding a storage item, these

changes were not applied to the card template when opening it in the designer.

The name-case formatting option did not change uppercase to lowercase when necessary.

When opening a design that is connected to an empty database table or view, the database columns were

not shown in the Data tab and in the drop-down menus on the Context menu, and any mappings were

shown as {Missing column}.

When specifying to print multiple copies in the print dialog, only a single copy is actually being printed.

Release 8.1.0.3 (May 1, 2013)

When a shape was added, an empty insert-window was shown.

When clicking on the Select-connection button in the Data menu and canceling the selection, the Edit and

Remove-connection buttons became enabled, even though there was no connection.

When there were non-existing database columns, selecting multiple objects could lead to a null-reference

exception.

If the My Pictures folder was not properly defined on a system, starting CardExchange® resulted in a fatal

error: “The type initializer for ‘CardExchangeDesignerX.cedImages’ threw an exception. Invalid URI: The

format of the URI could not be determined.”

When connecting to SQL Server and using a unique identifier as primary key, the following error could occur

when opening or viewing the version 7 designer: “Conversion from type ‘Guid’ to type ‘String’ is not valid.”

When navigating to a record for which no photo is available, with the background-removal option enabled for

that photo, a null-reference exception occurred.
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Using fixed values for concatenation fields caused CardExchange® to crash.

It was not possible to do contactless and magnetic encoding in the same print process using a Magicard Prima

4 or a DNP CX-D80.

In the properties window, the data for magnetic tracks was shown with escaped spaces (#32) and other

special characters.

Text data in magnetic tracks are now always converted to uppercase.

Made sure that a template can be opened in the designer if there is no connection to the database.

Adding a variable directly after starting up the designer caused a null-reference exception.

Special characters in the start and stop commands of magnetic tracks were shown escaped instead of

normally.

When exporting an image from the application menu, the saved image format was not in accordance with

the saved file extension.

Show the wait cursor for every command that is executed.

Release 8.0.3.2 (February 24, 2013)

When running the Designer edition, clicking the button Register CardExchange in the Service center resulted

in the error “The method or operation is not implemented.”

3.5 Four Click Interface

In this section you can find all the fixes, improvements, etc., for the Four Click Interface of CardExchange®.
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3.5.1 New Functionality

Release 8.1.4.0 (October 1, 2013)

Made it possible to run CardExchange in support mode, offering the possibility to choose the desired edition

prior to launching the main window. If the chosen edition is higher than the license one, the licensed edition

will launch.

Made it possible to run CardExchange with a networked demo license.

Release 8.0.1.0 (February 5, 2013)

Added the Service-center tab with news items and other support resources.

The registration process has been integrated in the activation wizard.

Added support for Signotec signature pads

3.5.2 Improvements

Release 8.1.2.0 (July 25, 2013)

The storage-item type (supply value, photo or signature) is now determined in the database setup and does

not need to be set anymore in the card setup. WARNING: If an existing template has a storage item that is

used for signatures or button-triggered plug-in output. It is necessary to select the correct storage item type

in the database setup, as by default they will be set to Photo.

When running in demo mode, the number of days left in the window header counts down from 42 to zero
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and then stays on zero forever (the demo mode never really expires).

Automatically open the user-authorizations wizard when logins are enabled and force the user to walk

through the wizard.

Changed the default time delay after printing to 0.1 second, to avoid slow printing in demo situations.

Do not show binary database fields in the new-card wizard when electing a binary database field makes no

sense (text columns, bar-code column).

Changed the page order for adding objects to the layout in the new-card wizard to background - logo - photo

and signature - text columns -bar code.

Changed logins feature to fit the new edition features list (Premium edition is limited to 5 groups and 7 users

and Professional edition doesn't allow password expire feature and specific user permissions definitions).

Release 8.1.2.0 (July 25, 2013)

Removed Video-for-Windows support.

Removed the old image editor, based on ImageEn.

Implemented proprietary TWAIN support, without using the ImageEn component.

Release 8.1.0.3 (May 1, 2013)

Now supporting Romanian language

Release 8.0.3.1 (February 18, 2013)

When no internet connection is available, CardExchange no shows a more user-friendly message instead of

an error message.

Replaced the splash screen shown when starting up CardExchange®.

Removed the 42-days limit from the trial license. CardExchange® can now run in trial mode for an unlimited

period of time. However, the texts in the window caption and the activation wizard, still refer to the 42-days

trial period.

Changed the text of the migration button into “Migrate version 6 layout”.

3.5.3 Bug Fixes

Release 8.1.4.0 (October 1, 2013)

When logging in as a user that cannot access to the last selected ribbon and cannot access the print tab

either, the print tab showed anyway, but with the buttons hidden. Now, it shows the first accessible tab,

checking the accessibility from the left to the right.

When logging in as a user that has access to the configuration ribbon but is not a member of the authorization

group, the authorizations group was still shown in the configuration tab, though disabled and with the

buttons hidden.

When an authorization setting was changed for a specific user, rather than for a user group, all other settings
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also became user specific (copied from the parent group). Now, only the modified setting is made user

specific and all other settings are determined by the groups the user belongs to.

When an error occurred at startup, for example, due to a failing database connection, it was not possible to

open and edit the advanced-options window.

Avoid that CardExchange, when starting, tries to open a card for which the current user is not authorized.

Avoid that the configuration buttons for the current card are not available after starting CardExchange with a

failing database connection.

The trial markers for PhotoExchange and PhotoExchange Pro were not shown when running in 30-days

Ultimate trial mode.

When an unsupported Signotec pad is used CardExchange freezes after the signature acquisition.

Release 8.1.3.0 (August 17, 2013)

When selecting the Printer properties in the context menu, a null-reference exception occurred.

The Topaz signature-pad SDK was pointing to the old version (1.1.3358.14336), even with the new file

(2.0.0.18) in the setup package.

Release 8.1.2.0 (July 25, 2013)

Removed options that do not apply to the current edition from the advanced-options form.

When taking a photo and capturing immediately after that a signature, the photo on the preview was

reverted to the previous one.

Sometimes, the company logo in the service-center ribbon did not show correctly.

Removed the empty navigator tab in the last page of the user-authorizations wizard.

Corrected the configurable of some help-menu options in the user-authorizations wizard.

When adding a new card without a database connection but with a photo or a signature, clicking Finish in the

new-card wizard caused a null-reference exception.

Release 8.1.0.3 (May 1, 2013)

When the Guest user was deleted in the user-authorizations wizard, clicking Next resulted in the following

error: “Deleted row information cannot be accessed through the row.”

Included the correct version the SigPlusNET.dll for signature-pad support.

When the connection to a database was not successful, it was not possible to start up the Data Base

Connection Wizard to correct the settings.

Release 8.0.3.1 (February 18, 2013)

The designer was displayed in Spanish if the language was set to Portuguese and some Portuguese

translations were missing in the main interface.
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When no posts were available, the no-posts message was shown in the operating system’s language instead

the selected CardExchange language.

Release 8.0.2.0 (February 13, 2013)

When no valid demo license was found or the demo license was expired, it was still possible to select

evaluate in the activation wizard, which would result various error messages.

When clicking Next in the activation page of the activation wizard, no wait cursor was shown, despite the fact

that it could take about second before the next page was shown.

In the activation wizard, the registration input fields were initially enabled despite the fact that the

registration option was initially unchecked.

The use trial period option is now disabled when no trial period is available.

When the registration form was called without internet connection, an activation error was shown, instead of

a normal pop-up error.

The registration reminder shown when closing CardExchange was still referring to the old registration

website.

When upgrading CardExchange from an older version, the demo license code was not installed and

CardExchange could not be run in demo mode unless the lservrc file was deleted first.

When enabling the Migrate button in the Entry edition, the Authorization became visible.

Release 8.0.0.0 (February 5, 2013)

In some languages, the formatted names were shown with parenthesis around each name (Danish,

Norwegian, Greek and Indonesian).

3.6 DataExchange

In this section you can find all the updates with regards to the available database connectivity functionality.

3.6.1 Bug Fixes

Release 8.1.4.0 (October 1, 2013)

When having a binary photo field in the database and setting its printing requirements to Skip record or Halt

batch, the following error occurred when printing the card: “Error while printing the card. Conversion from

type 'Byte()' to type 'String' is not valid.”

Remove any non-printable characters from the values of string-type database columns, to avoid illegal-

character errors in the designer.
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3.7 PhotoExchange

In CardExchange® we offer a lot of photo capture functionality. In this section of the release notes you will find
all the new functionality, improvements, and bug fixes for this functionality. 

3.7.1 Bug Fixes

Release 8.1.2.0 (July 25, 2013)

The live image was distorted if another crop ratio tan 3:4 was selected for the photo.

3.8 MifareExchange

This section contains all updates with regards to Improvements, Bug Fixes, Improvements, etc. for the MIFARE®
Classic encoding functionality. This functionality is available in our Ultimate Edition.

3.8.1 New Functionality

Release 8.1.0.3 (May 1, 2013)

Added MIFARE® Classic support for OmniKey 5x27 CK readers.

3.9 DESFireExchange

This section contains all updates with regards to Improvements, Bug Fixes, Improvements, etc. for the MIFARE®
DESFire encoding functionality. This functionality is available in our Ultimate Edition.

3.9.1 New Functionality

Release 8.1.0.3 (May 1, 2013)

The DESFire definition wizard now supports the MIFARE® Secure Application Module SAM AV2 on OmniKey
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5x21 dual card readers.

Support the creation of value files.

3.9.2 Bug Fixes

Release 8.1.4.0 (October 1, 2013)

Since the introduction of support for value files, it was not possible anymore to read data from backup data

files, even though the command interface is the same as for standard data files.

Release 8.1.0.3 (May 1, 2013)

Corrected the text of the master-key setting that allows for creating (and not for deleting) applications

without authentication.

It was not possible to specify diversification input that contained the card´s UID when using the OmniKey

reader with SAM AV2.

3.10 PrinterExchange

In this section you can find all the updates with regards to the available printer functionality.

3.10.1 New Functionality

Release 8.0.0.0 (February 5, 2013)

Added support for Zebra ZXP7 inline contactless encoding.

3.10.2 Improvement

Release 8.1.0.3 (May 1, 2013)

Updated Pointman SDK to version 2.1.5.3 to support firmware V142.

3.10.3 Bug Fixes

Release 8.1.4.0 (October 1, 2013)

When error 0x01062800 (Medium Changed) occurs with a JVC CX-D80 or Magicard Prima 4, the software will

wait until the printer finishes to load the card into the encoder position instead of throwing an exception. This

is not a fault condition but rather a status message.
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